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Preface
This guide shows you how to use PaperPort and PaperPort Deluxe 
software from ScanSoft, Inc. Please read this preface for information 
about the following items:

• related information

• technical support

Please note that this manual is designed for readers who are already 
familiar with the operation of their computers, peripheral equipment 
(scanners, digital cameras, printers), and the Windows operating 
system.

RELATED INFORMATION

While this guide is enough to get you started, take advantage of the 
variety of other information that is available:

Web. Visit ScanSoft’s Web site at www.scansoft.com where you can find 
Technical Notes, Frequently Asked Questions (FAQs), software updates, 
and more. For a quick way to access information on the Web site, 
choose a category from the Internet menu.

CD. Access the CD, your source for installing additional software that 
works with the PaperPort software and for viewing the online 
documentation.

Help. Get help fast. Everything you want to know about PaperPort—
how to procedures, dialog box reference, and troubleshooting advice.

Scanner or other peripheral device documentation. Consult the 
documentation that came with your scanner, multi-function printer, 
digital camera, or other image-capture device.
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TECHNICAL SUPPORT

If you should experience problems with PaperPort that you cannot 
resolve on your own using the documentation and software, go to: 

www.scansoft.com 

The ScanSoft Web site provides a link to PaperPort pages, including 
Technical Support with Frequently Asked Questions, technical 
information bulletins, and a problem report form. 

Before sending a problem report form to ScanSoft Technical Support, 
be sure to visit FastTrack, ScanSoft’s electronic support system on the 
web site. Using an Intelligent Expert Reasoning™ methodology, 
FastTrack delivers intuitive self-service via the Internet and allows you 
to successfully resolve your problems online 24 hours a day, seven days a 
week. Software downloads, product upgrades and product updates are 
also available in FastTrack.

If you still cannot resolve your problem, contact ScanSoft Technical 
Support. Make a note of the following information to help in solving 
the problem:

• Your software version number. (This is in the Help menu under 
About PaperPort.)

• Your scanner (or other image-capture device) make and model

• A description of the steps that led up to the problem

• If PaperPort generated an error message, an exact description of the 
error message or its number and when it appeared.



                       
Working with PaperPort 
and PaperPort Deluxe

This guide shows you how to use some of the PaperPort and PaperPort 
Deluxe software features to view items, create stacks, send items 
electronically to PaperPort Links, add annotations, file items in folders, 
capture Web pages (PaperPort Deluxe only), and edit color images. The 
examples in this guide usually represent the PaperPort Deluxe software. 
However, in most cases, these examples are similar to what you see if 
you are using the basic PaperPort software. 

VIEWING ITEMS IN DESKTOP VIEW

PaperPort provides several ways to view items: Desktop View displays a 
thumbnail, a small graphic that represents each item in a folder. 
You can see PaperPort items (max files) and non-PaperPort items 
(items created using other applications, such as Microsoft Word). 
With PaperPort Deluxe, the thumbnails of both PaperPort and non-
PaperPort items show actual images of the items. Non-PaperPort items 
also include an icon which indicates the application used to create the 
item. With basic PaperPort, a non-PaperPort item is represented by a 
small rectangular thumbnail and not an actual image. 

To view items in Desktop View:

• Double-click the PaperPort icon on the Windows desktop. This 
opens PaperPort, and displays its Desktop View:
7
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VIEWING AN ITEM IN PAGE VIEW 
The Desktop View and Page View are separate applications that you can 
run individually or at the same time. Page View displays a close-up view 
of one page so that it is readable on the screen. 

In Page View, you can view PaperPort items. You can also view non-
PaperPort items (items created using other applications) with PaperPort 
Deluxe. You can adjust and edit the quality, color, and other aspects of a 
PaperPort image by using the Image Editing toolbar. With the 
annotation tools, you can add comments, highlight or circle 
information, or add a picture to a PaperPort item.

The Command Bar has 
shortcuts for choosing 
menu commands, such 
as changing views. 

Use the Folder View to 
navigate between differ-
ent folders and to file and 
organize items. 

Thumbnail of a 
PaperPort item

The Link Bar has icons that represent other applications 
and functions that work with PaperPort. The icons vary, 
depending on the applications installed on your computer. 

Stacks are PaperPort 
items that have been 
combined. Stack titles 
appear in bold type 
above the page titles. 

The status bar shows 
information about the 
selected item, link, or 
button. 

Use the scroll arrow to 
view other links on the 
Link Bar. 

Thumbnail of a non-PaperPort item, in this 
case a Word file (in PaperPort Deluxe).
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To view a PaperPort item in Page View:

• In Desktop View, double-click a PaperPort item or select a PaperPort 
item, and then click the Page button on the Command Bar. You can 
also double-click a PaperPort item in Windows Explorer to view it in 
Page View.

To view a non-PaperPort item in Page View 
(PaperPort Deluxe only):

• In Desktop View, Shift-double-click a non-PaperPort item, or select a 
non-PaperPort item, and then click the Page button on the 
Command Bar.

Note: You can set a preference in Page View that lets you open 
multiple Page View windows at the same time. For more information 
about preferences, see the online Help. 

The Command Bar has 
shortcuts for menu 
commands. 

The Annotation toolbar 
has tools for adding 
notes, highlighting ar-
eas, cutting and pasting 
a selection, adding a pic-
ture, and so on. 

The status bar shows
information about the 
current page.

The Image Editing toolbar has tools for editing an 
image, improving the quality, or adjusting the color. 
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To change between Desktop View and Page View:

VIEWING ITEMS BY USING THE APPLICATION THAT 
CREATED THEM

From the Desktop View, you can start a non-PaperPort item’s 
application and use it to view the item.

To view a non-PaperPort item in its application:

• In Desktop View, double-click a non-PaperPort item. 
The application that created the item starts and the item appears.

If you want, with PaperPort Deluxe you can change the Double Click 
Action preference so that the item appears in Page View when you 
double-click it. For more information, see the online Help.

CREATING STACKS

With PaperPort, you can electronically organize PaperPort items 
(including captured Web pages) into stacks in much the same way that 
you do with paper documents. A stack is a PaperPort item with multiple 
pages. You cannot stack non-PaperPort items. (However, with PaperPort 
Deluxe you can easily convert a non-PaperPort item to PaperPort by 
right-clicking the item and choosing Duplicate as PaperPort Item.)

1. In Desktop View, 
select the item you 
want.

2. Click the Page 
button. 

3. To return to 
Desktop View, click 
the Desktop button.
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To create a stack:

A new stack receives the title of the item on the bottom of the stack. 
The stack title (the name of the newsletter, “Spring Vol 42” in this case) 
is shown in boldface type. Each page title is shown in normal typeface 
(“Cover Letter” in the example). 

1. In the Desktop View, 
select the PaperPort 
item that you want to 
stack.

This example shows 
stacking a Cover 
Letter on the Spring 
Vol 42 newsletter.

Cover Letter Spring Vol 42

2. Drag the selected item 
onto the PaperPort 
item on which you 
want to stack it.

3. When the second item 
is highlighted, release 
the mouse button.

The stack is created.

4. Repeat Steps 1 through 
3 until you finish 
creating the stack.

Cover Letter Spring Vol 42

Cover Letter
Spring Vol 42

Note: When you select multiple items to stack, PaperPort stacks them 
in the order in which they were selected.
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MOVING BETWEEN STACKED PAGES

In Desktop View, use the Page Navigator on a stack to move through a 
stack’s pages. You can also use the First Page, Last Page, Previous Page, 
and Next Page commands on the Page menu to move from page to 
page. 

To move between pages in a stack in Desktop View:

To move between pages in a stack in Page View:

FAXING OR E-MAILING AN ITEM

The PaperPort software is designed to work with—or link to—other 
types of applications. To send items to other applications, you use the 
Link Bar, located at the bottom of the PaperPort Desktop window. The 
Link Bar automatically displays link icons for applications installed on 
your computer and supported by the PaperPort software, such as 
electronic fax, e-mail, image editing, and word-processing applications. 

1. Select the stack.

2. Click the left arrow of 
the Page Navigator to 
see the previous page 
in the stack.

3. Click the right arrow 
of the Page Navigator 
to see the next page in 
the stack, or click the 
middle of the Page 
Navigator to go to a 
specific page.

1. Display the stack. 

2. Click the << Page 
or Page >> button. 
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After an item is displayed in Desktop View, you can send it as a fax, or 
as an attachment to an e-mail message, by using the Link Bar. You do 
not need to print the item first; you can send it directly from PaperPort. 

To fax an item, your computer must have a fax modem and fax 
software. To attach an item to an e-mail message, you need an e-mail 
account and e-mail software. 

To fax an item from Desktop View:

Note: You can change the link application preferences by choosing 
Link Preferences from the Edit menu. For more information, see the 
online Help.

1. Select the item to 
fax.

2. Drag the item onto 
the fax link icon on 
the Link Bar. 

You can also click 
the item, and then 
click the fax link 
icon.
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To send an item using an e-mail application:

• Repeat the steps as described for faxing an item in the preceding 
procedure, except, drag the item onto your e-mail link icon on 
the Link Bar. 

If you are attaching items to an e-mail message, the e-mail software 
starts. After you log in, the item appears as an attachment to the 
e-mail message. 

3. When your fax 
software starts, send 
the scanned item as 
a fax. 

This example shows 
the Symantec 
WinFax PRO 
window for sending 
a fax. The window 
that appears on your 
computer will be for 
your fax software.

Note: To send an item to a link from Page View, choose Links from 
the File menu, and then choose the name of the link application.

Note: When you send an item as an e-mail message, you can make 
the message self-viewing. Recipients of the e-mail message can view 
the attached PaperPort item even if PaperPort is not installed on their 
computers. To create this type of e-mail attachment, choose Self 
Viewing Files as the Send Format in the Links preferences, before 
you send the item. For more information, see the online Help.
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CONVERTING A PAPERPORT ITEM TO TEXT

A PaperPort item is an image. Even the text on a scanned item is simply 
a picture of the text, and you can’t edit it as you would text in a word-
processing document. If a supported word-processing icon such as 
Word appears on the Link Bar, you can use PaperPort to convert the 
item to text. The PaperPort software performs this conversion by using 
the built-in OCR (optical character recognition) software provided with 
PaperPort. After converting an image into text, you can edit the file by 
using a word-processing application, such as Word.

To convert a PaperPort item to text from Desktop View: 

1. Select the PaperPort 
item to convert. It can 
be a single page or a 
stack.

2. Drag the item onto 
the word-processing 
link icon on the Link 
Bar. 

You can also just click 
the word-processing 
link icon.

3. When the word-
processing link icon is 
highlighted, release 
the mouse button. 

The OCR software 
displays a progress 
window while the 
conversion is in 
process. 

Note: This example shows the steps for using PaperPort’s built-in 
OCR software and sending the converted text directly to Word. 
If you have other OCR software installed on your computer, you can 
convert the item by dragging the item to the OCR application on the 
Link Bar. 
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FILING ITEMS IN FOLDERS

Desktop View provides an easy-to-use filing system for organizing your 
items. The filing system consists of folders shown in the Folder View 
and items shown on the Desktop. With PaperPort Deluxe, you can add 
other folders or attached devices, such as Zip disks or external hard 
drives, to the Folder View. 

With the PaperPort software, you can save items in separate folders 
similar to ordinary file folders, except that they are electronic. You can 
use folders to store and organize all your items. Although PaperPort has 
certain default folders, you can add new folders or change any folder’s 
title and color. 

4. When the conversion 
is complete, the word-
processing application 
opens, and you can 
begin editing the text. 
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ADDING FOLDERS TO THE FOLDER VIEW (PAPERPORT DELUXE ONLY)

Adding a folder to the Folder View lets you use PaperPort to see a folder 
and its items that are located on your hard disk or on another device 
connected to your computer. After you add a folder to the Folder View, 
you can view any of its folders or items in Desktop View. 

To add a folder to Folder View:

1. In Desktop View, choose Add to Folder View from the File menu. 
The Add to Folder View dialog box appears. 

It shows the same device and folder information that you see in 
Windows Explorer.

2. Select the folder on a drive or disk that you want to add to Folder 
View and click OK.

The folder and its subfolders appear in the Folder View and items in 
the added folder appear on the Desktop. An icon identifies the folder 
as an added folder. In addition, the actual location of the folder on 
your computer, such as the C drive, appears in the folder title. 

The items of one of the 
folders appear on the 
Desktop. 

The ScanSoft Documents 
folder and these subfolders 
are provided with 
PaperPort.
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To see the contents of a folder:

Note: When you first add a folder to the Folder View, choose Refresh 
Thumbnails from the View menu.

1. In the Folder View, 
click a Folder or click 
the plus sign next to a 
folder if one appears.

Any subfolders 
included in the folder 
appear in the Folder 
View. Items appear on 
the Desktop.

2. Click a subfolder to 
display its contents. 
Any items in the folder 
appear on the 
Desktop. 

This example shows 
four items in the 
Newsletters folder, 
which is located in 
the Articles folder.
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FILING ITEMS IN FOLDERS BY USING DESKTOP VIEW

You can use the folders to store and organize different items. The easiest 
way to move an item into a folder is by dragging and dropping the item. 
You can file items one at a time, or you can file multiple selected items 
all at the same time.

To drag and drop an item into a folder:

Note: If you place an item into PaperPort, such as by scanning or 
capturing a Web page (PaperPort Deluxe only), the item is placed in 
the location that is currently selected in Desktop View. For example, 
if the Articles folder is selected and its items appear in Desktop View, 
then a scanned item is placed in the Articles folder.

1. Click an item to select 
it. Use Ctrl-click to 
select multiple items.

2. Drag the selected 
item onto a folder.

3. When the folder is 
highlighted, release 
the mouse button.

To open a folder and 
see its contents, click 
the folder. 

Tip: To make a copy of an item and leave the original in its original 
folder, hold down the Ctrl key when dragging an item to a folder or 
select the item, and then choose Copy to Folder from the Desktop 
menu. 
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CREATING A NEW FOLDER

By adding new folders, you can create a set of folders that work best for 
different items, such as bills, expenses, memos, or personal and business 
correspondence. You can use PaperPort to create subfolders for any of 
the folders shown in the Folder View.

To add a folder:

USING WINDOWS EXPLORER TO MANAGE ITEMS 

The previous procedures tell you how to work with folders and items 
from the Desktop View. You can also use Windows Explorer to complete 
changes, such as retitling a folder and filing items in different folders. 
The changes you make in Windows Explorer are directly reflected in 
Desktop View. Likewise, any changes you make in Desktop View are 
visible in Windows Explorer.

1. Click the location 
in which you want 
to add a folder.

2. From the File 
menu, choose 
New, and then 
Folder.

3. Type the new 
folder’s title. 

4. Select a color from 
the drop-down 
list, and then click 
OK. 

The new folder 
appears in the 
Folder View. 

Tip: To change a folder’s title, select the folder title in the list, and 
then click it again. Type the new title and press Enter. 
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To make changes in Windows Explorer:

1. In Desktop View, 
click the Explorer 
button on the 
Command Bar. 

Windows Explorer 
appears.

2. Use Windows 
Explorer to make 
changes to folders or 
items that appear in 
Desktop View. For 
example, you can 
retitle a folder or drag 
and drop items into 
different folders.

You can also drag 
items from Windows 
Explorer directly to 
PaperPort.
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CAPTURING WEB PAGES (PAPERPORT DELUXE ONLY)
When you install BookMark Express as part of the PaperPort 
installation and sign into BookMark Central.com, you gain a set of 
tools for capturing, viewing, and managing your favorite web sites, both 
in PaperPort and in your web browser.

In the PaperPort Desktop, BookMark Express adds a “My Bookmarks” 
folder view that automatically synchronizes with the “Favorites” in your 
web browser (Internet Explorer or Netscape Navigator). It displays 
thumbnail views of these web documents on the PaperPort Desktop:

BookMark Express also places a Web Capture command directly in the 
Favorites menu of your web browser. With Web Capture, you can easily 
add Web pages directly to the Desktop View and automatically update 
them the next time you connect to the Internet. For example, you can 
capture information about your favorite stocks and then automatically 
update the Web page to reflect the latest numbers. 

BookMark Express adds a 
“My Bookmarks” folder 
view to your PaperPort 
desktop.

Your Web Favorites are 
shown as web documents 
in PaperPort.

Tip: You might find it convenient to create a new folder that you can 
use to store all of your Web captures.
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To capture a Web page and display it: 

1. In the Folder View of the PaperPort Desktop, select the folder in 
which you want to add a Web page.

2. Connect to the Internet and, in your Internet browser, display the 
Web page that you want to capture.

3. From your Internet browser’s Favorites menu, select the Web 
Capture command, and then choose Capture Visible Portion. The 
Web page is saved to the PaperPort Desktop as a special PaperPort 
item identified by your browser’s application icon.

To capture an entire Web page that contains multiple screens of 
information, select the Web Capture command, and then choose 
Capture Entire Page. Each full screen of information is saved as a 
separate page in a stack. 

To update a captured Web page: 

1. Connect to the Internet.

2. In Desktop View, double-click the Web page item. 

A view of the Web page as it currently exists on the Internet appears.

3. To update the page, select the Web Capture command, and then 
choose Capture Visible Portion or Capture Entire Page, depending 
on the currently captured Web page. A message appears asking if you 
want to update the page or create a new one.

To update your current capture, click Update Existing. 

To create another Web page capture, (leaving the originally captured 
Web page as is), click Create New. A copy of the Web capture 
appears in Desktop View.

Additional BookMark Express tools are available from the BookMark 
Central.com icon on your Windows taskbar and integrated within your 
Web browser. For more information about using these tools, refer to the 
BookMark Express QuickStart Guide.

Tip: To view a captured Web page in Page View, Shift-double-click 
the captured Web page item in Desktop View. If you make any 
changes to a captured Web page, you cannot automatically update it.
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ANNOTATING A PAGE

With the annotation tools, you can add a note, highlight text, draw lines 
or arrows, circle information, or paste a picture into a PaperPort item 
(including Web page captures.) For example, you might add a note that 
tells you when the item needs to be processed and returned to the sender. 
You cannot add annotations to non-PaperPort items.

You add annotations by displaying an item in Page View and using the 
Annotation toolbar. All the annotation tools are used in the same 
manner; therefore, this section shows only how to use one tool. 
For more information about each tool and how to use it, see the online 
Help. 

To add an annotation:

Note: In Desktop View, PaperPort displays small icons, such as an 
arrow or yellow note, on a page’s thumbnail for each annotation.

1. In Page View, 
click the tool on 
the Annotation 
toolbar.

2. Place the cursor on 
the page. Its shape 
will indicate the 
tool you selected.

3. Depending on the 
tool you selected, 
click or drag the 
cursor to use the 
tool, such as to add 
a note.
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ADJUSTING PICTURES 
Whether you are photographing houses for sale, displaying the newest 
model car, or just storing your favorite photographs as PaperPort items, 
you can edit these color or grayscale pictures using PaperPort’s image-
editing tools. The Image Editing toolbar contains all of the tools for 
adjusting color as well as grayscale images. 

IMPROVING PICTURES AUTOMATICALLY

AutoFix Picture analyzes a picture and tries to improve that picture. 
PaperPort’s sophisticated internal system can automatically adjust the 
color, brightness, and contrast to produce a good picture. AutoFix 
Picture works well to improve poor-quality pictures. 

Note: The Image Editing tools work only with PaperPort items. 
A quick way to convert an image to a PaperPort item is to right-click 
the image, and then choose Duplicate as PaperPort item.

Tip: To manually adjust the brightness, contrast, color, or tint of a 
picture, use the Adjust Picture command or the Picture wizard. For 
more information, see the next section, “Adjusting a picture 
yourself ”.
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To improve a picture automatically:

ADJUSTING A PICTURE YOURSELF 

Sometimes you have a photograph that is too light or too dark, or 
whose color is not right. If you prefer to make the adjustments and 
enhancements to a picture yourself, you can use the Adjust Picture 
command. 

When you select Adjust Picture, PaperPort displays samples of the 
original picture adjusted slightly. From the sample pictures, you can select 
the one you like best. If you don’t like any of these pictures, select one of 
the options, such as the Color option, and then adjust just the color. All 
the sample pictures adjust relative to the center picture. You can either 
select the sample picture you like best and save it or adjust the picture 
again. You can also click Undo All Changes and Undo Last Change to 
undo changes.

1. Display the picture in 
Page View.

2. Click the AutoFix 
Picture tool on the 
Image Editing toolbar, 
or choose AutoFix 
Picture from the Page 
menu.

PaperPort begins 
adjusting the picture 
to improve its quality.

Image Editing toolbar 

Tip: To learn how to use Adjust Picture, click the Wizard icon on the 
Image Editing toolbar. The Picture wizard shows you step-by-step 
how to adjust the brightness, contrast, tint, and color. 
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To adjust and enhance a picture yourself:

The Adjust Picture dialog box appears. 

1. Display the color 
picture in Page View.

2. Click the Adjust 
Picture tool on the 
Image Editing 
toolbar. 

Current picture. This pic-
ture has a dark blue border 
and appears in the center 
of the Adjust Picture dia-
log box. 

Options to change col-
or, brightness, contrast, 
or tint.

Adjustment slider for 
changing samples.

Original picture.
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To adjust the color:

To select the picture you like best:

When you select a picture, it moves to the center. All the other sample 
pictures change relative to the new current picture. If you don’t like the 
changes, click the Undo Last Change or Undo All Changes button to 
undo the changes. 

PaperPort does not save the settings, such as the amount of change, in 
the Adjust Picture dialog box; therefore, if you reopen the dialog box, 
the default settings appear. 

3. Select the Color 
option.

4. Drag the slider to 
the left for less color 
or to the right for 
more color. 
PaperPort adjusts 
all eight sample 
pictures. 

5. Click the picture that 
has the color you like 
best. It moves to the 
center and becomes 
the current picture.

6. To adjust another 
setting, repeat Steps 
1 through 5, 
choosing another 
setting. 

7. After you finish all 
adjustments, click 
OK to save the 
changes. 

Click to undo the last change.

Tip: If you want to ensure that your original picture is unchanged, 
make a copy of the picture by using the Duplicate Item command 
before opening the Adjust Picture dialog box. 
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FINDING ITEMS

With PaperPort you can use the Find Item feature to locate items by 
name, date, or keywords. With PaperPort Deluxe, Find Item includes 
the powerful SimpleSearch feature which lets you find items based on 
the textual content. For example, if you remember only that the item 
included the word “California” or the phrase “…California coast,” 
SimpleSearch can find the item containing that word or phrase. 

To find an item:

1. In Desktop View, choose Find Item from the Search menu.

2. In the Search For field, enter text to identify the item.

3. Select one or more checkboxes such as Content or Keywords 
to identify where to search for the text.

4. Select the buttons to find just the first item, or all items that 
have that text. 

5. Click Find.

For more information about SimpleSearch and using Summary 
Information in a search, see the online Help. 
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SCANNING TO A LINK APPLICATION WITH SCANDIRECT 
(PAPERPORT DELUXE ONLY)
With ScanDirect, you can scan an item and send it to a linked 
application without starting PaperPort. ScanDirect is a control panel 
that runs in the background on your computer, and when minimized, 
the ScanDirect Control Panel icon appears on the Windows taskbar. 
Like PaperPort, you first select the target link that you want to use in 
ScanDirect and then scan the item to send it directly to that link 
application.

The basic steps to use ScanDirect are the same for each application 
icon. The following example shows how to set the preferences for 
Photoshop, scan an item, and open that item in Photoshop.

To use ScanDirect:

Note: To scan an item with your PaperPort flatbed scanner and send 
it to ScanDirect, you use the PaperPort Scan Manager dialog box. For 
more information, see the online Help.

1. On the Windows 
desktop, double-click 
the ScanDirect 
shortcut.

The ScanDirect 
control panel appears. Scan single page Scroll arrows

ScanDirect icons

About 
ScanDirect

Help button

Scan to PaperPort 
Desktop

Displays Scan 
Manager dialog 
box

Scan multiple pages

Note: The Scan Single Page and Scan Multiple Page icons are not 
available for flatbed scanners, only sheetfed scanners.
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FILLING IN PREPRINTED FORMS WITH FORMTYPER 
(PAPERPORT DELUXE ONLY)
In the past, you had to use a typewriter or a ballpoint pen to fill in the 
fields manually on preprinted forms. With the FormTyper application, 
you can enter data by using your computer and then print the form. 
The end result is the preprinted form, filled with data just as if you had 
used a typewriter. 

2. Right-click the 
Photoshop icon and 
choose Preferences. 
The Link Preferences 
dialog box appears.

3. Select the preferences 
and click OK.

4. Click the Photoshop 
icon on the control 
panel.

5. Click the button for 
scanning.

If you have a TWAIN 
scanner, the button 
looks like this. 

Your image is 
scanned and appears 
in Photoshop.
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To fill in a form:

3. Begin typing data if the cursor is at the first field that you want to fill in. 

To type in any other field, click the field.

To add another line to a field, press Enter.

4. When you’re finished typing in a field, press the Tab key or the left or 
right arrow keys to move to the next field.

5. After completing the form, save it by choosing Save to PaperPort 
Desktop As from the Form menu.

6. Type a name for the filled-in form and click OK.

The form appears on the Desktop. The “A” symbols indicate fields 
filled with text annotations. 

1. Place a form in 
Desktop View, for 
example, such as by 
scanning the form.

2. Select the form, and 
then click the 
FormTyper link.

FormTyper analyzes 
the form to find its 
fields and opens the 
FormTyper window. 
The fields are 
underlined in blue, and 
the cursor is at the first 
field to be filled in. 
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